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Abstract 
 

  
These Application Notes describe the configuration steps required for Spirent Abacus 5000 to 
successfully interoperate with Avaya Communication Manager using the ISDN PRI and 
analog interfaces.  Information in these Application Notes has been obtained through 
compliance testing and additional technical discussions.  Testing was conducted via the 
DeveloperConnection Program at the Avaya Solution and Interoperability Test Lab. 
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1. Introduction 
Spirent Abacus 5000 is an integrated IP and PSTN telephony test system with analog, TDM, and 
Ethernet interfaces.  The system generates real voice streams to simulate real-world loads, and 
performs real time voice quality measurements. 
 
Abacus 5000 can function as a call generator or a switch.  The compliance testing focused on 
Abacus 5000 as an ISDN PRI call generator to load Avaya Communication Manager with 
termination of the load to analog endpoints on Abacus 5000. 
 
In the integration of Abacus 5000 with Avaya Communication Manager, Abacus 5000 utilizes an 
ISDN capable PCG3B card to originate the ISDN PRI calls to Avaya Communication Manager, 
and an analog capable ECG3 card to terminate the calls.  The outgoing ISDN PRI calls from 
Abacus 5000 arrive on Avaya Communication Manager via the ISDN trunk interface, and are 
routed back out to Abacus 5000 via the analog station interface.  The ports on the Abacus 5000 
ECG3 card are administered as analog stations on Avaya Communication Manager.   
 
The Abacus 5000 originating PCG3B card is physically connected to the DS1 Interface circuit 
pack on Avaya Communication Manager, and the Abacus 5000 terminating ECG3 card is 
physically connected to the Analog Line circuit pack on Avaya Communication Manager.   
 

 
 
The compliance testing involved originating calls from the Abacus 5000 across an ISDN trunk 
and terminating these same calls on the Abacus 5000 as generic analog endpoints.  The 
information from these Application Notes can easily be extended to other possible test scenarios 
such as: 
 

Originating From Terminating To 
Abacus Trunks Avaya Endpoints 
Abacus Trunks Abacus Trunks 
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1.1. Abacus 5000 PCG3B and ECG3 Capacity 
For the compliance testing, five simultaneous calls were configured and launched on Abacus 
5000, thus involving five channels on the originating PCG3B card and five channels on the 
terminating ECG3 card.  Below is a table listing of the capacity of the PCG3B and ECG3 cards 
from the Abacus 5000 documentation: 
 

 

2. Equipment and Software Validated 
The following equipment and software were used for the configurations provided: 
 

Equipment Software 
Avaya S8700 Media Servers  Communication Manager 3.0.1, load 346.0 

Avaya MCC1 Media Gateway 
• TN464GP DS1 Interface 
• TN742     Analog Line 

 
HW02  FW015 
19 

Spirent Abacus 5000 3.2, patch 14 
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3.1. 

3. Configure Avaya Communication Manager 
The procedures for configuring the ISDN PRI trunk and analog station interfaces on Avaya 
Communication Manager include the following areas: 
 

• Verify Avaya Communication Manager License 
• Administer DS1 Circuit Pack 
• Administer ISDN trunk group 
• Administer ISDN signaling group 
• Administer ISDN trunk group members 
• Administer analog stations 

Verify Avaya Communication Manager License 
Log into the System Access Terminal (SAT) to verify that the Avaya Communication Manager 
license has proper permissions for features illustrated in these Application Notes.  Use the 
“display system-parameters customer-options” command to verify that the ISDN-PRI option is 
set to “y” on Page 4, as shown below. 
 
display system-parameters customer-options                      Page   4 of  11 
                                OPTIONAL FEATURES 
 
   Emergency Access to Attendant? y                              IP Stations? y 
           Enable 'dadmin' Login? y               Internet Protocol (IP) PNC? n 
           Enhanced Conferencing? y                        ISDN Feature Plus? y 
                  Enhanced EC500? y            ISDN Network Call Redirection? n 
    Enterprise Survivable Server? n                          ISDN-BRI Trunks? n 
       Enterprise Wide Licensing? n                                 ISDN-PRI? y 
              ESS Administration? n               Local Survivable Processor? n 
          Extended Cvg/Fwd Admin? y                     Malicious Call Trace? y 
     External Device Alarm Admin? n                 Media Encryption Over IP? n 
  Five Port Networks Max Per MCC? n     Mode Code for Centralized Voice Mail? n 
                Flexible Billing? n 
   Forced Entry of Account Codes? y                 Multifrequency Signaling? y 
      Global Call Classification? n Multimedia Appl. Server Interface (MASI)? n 
             Hospitality (Basic)? y         Multimedia Call Handling (Basic)? y 
 Hospitality (G3V3 Enhancements)? y      Multimedia Call Handling (Enhanced)? y 
                       IP Trunks? y 
 
           IP Attendant Consoles? n 
        (NOTE: You must logoff & login to effect the permission changes.) 
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3.2. Administer DS1 Circuit Pack 
Administer a DS1 circuit pack to be used for connectivity to the originating PCG3B card from 
Abacus 5000.  Use the “add ds1 1b08” command.  Note that the actual slot number may vary.  In 
this case “1b08” is the slot number.  Enter the following values for the specified fields, and retain 
the default values for all remaining fields.  Submit these changes. 
 

• Name:   A desirable name. 
• Line Coding:    “b8zs” 
• Signaling Mode:    “isdn-pri” 
• Connect:           “line-side” 
• Protocol Version:   “b” 

 
Note that for the compliance testing, the DS1 circuit pack is configured for ISDN PRI service.  
Modify the DS1 settings as necessary to reflect the actual network configuration. 
 
add ds1 1b08                                                    Page   1 of   2 
                                DS1 CIRCUIT PACK 
 
            Location: 01B08                           Name: Abacus PRI T1 
            Bit Rate: 1.544                    Line Coding: b8zs 
   Line Compensation: 1                       Framing Mode: esf 
      Signaling Mode: isdn-pri 
             Connect: line-side 
   TN-C7 Long Timers? n                   Country Protocol: 1 
Interworking Message: PROGress            Protocol Version: b 
Interface Companding: mulaw                            CRC? n 
           Idle Code: 11111111 
                              DCP/Analog Bearer Capability: 3.1kHz 
 
                                           T303 Timer(sec): 4 
 
 
      Slip Detection? n                 Near-end CSU Type: other 
                          Alarm When PRI Endpoint Detached? y 
                                 Block Progress Indicator? N 
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3.3. Administer ISDN Trunk Group 
Administer an ISDN PRI trunk group to interface with the originating ICG3 card from Abacus 
5000.  Use the “add trunk-group n” command, where “n” is an available trunk group number.  
Enter the following values for the specified fields, and retain the default values for all remaining 
fields.  Submit these changes. 
 

• Group Type:   “isdn” 
• Group Name: A descriptive name. 
• TAC:  An available trunk access code. 
• Service Type: “tie” 

 
add trunk-group 62                                              Page   1 of  20 
                                TRUNK GROUP 
 
Group Number: 62                   Group Type: isdn          CDR Reports: y 
  Group Name: Abacus PRI T1 Trunk         COR: 1        TN: 1        TAC: 1062 
   Direction: two-way        Outgoing Display? n         Carrier Medium: PRI/BRI 
 Dial Access? n                Busy Threshold: 255       Night Service: 
Queue Length: 0 
Service Type: tie                   Auth Code? n            TestCall ITC: rest 
                         Far End Test Line No: 
TestCall BCC: 4 
TRUNK PARAMETERS 
         Codeset to Send Display: 6     Codeset to Send National IEs: 6 
        Max Message Size to Send: 260   Charge Advice: none 
  Supplementary Service Protocol: a     Digit Handling (in/out): enbloc/enbloc 
 
            Trunk Hunt: cyclical 
                                                   Digital Loss Group: 13 
Incoming Calling Number - Delete:     Insert:                 Format: 
              Bit Rate: 1200         Synchronization: async    Duplex: full 
 Disconnect Supervision - In? y  Out? n 
 Answer Supervision Timeout: 0 
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3.4. Administer ISDN Signaling Group 
Administer an ISDN signaling group for the newly added trunk group.  Use the “add signaling-
group n” command, where “n” is an available signaling group number.  For the Primary D-
Channel field, enter the slot number for the DS1 circuit pack from Section 3.2 and port “24”.   
For network configurations using the ISDN E1 service, use port “16” instead of “24” for the 
Primary D-Channel field. 
 
For the Trunk Group for Channel Selection field, enter the ISDN trunk group number from 
Section 3.3.  Maintain the default values for the remaining fields, and submit these changes. 
 
add signaling-group 62                                          Page   1 of   5 
                                SIGNALING GROUP 
 
 Group Number: 62             Group Type: isdn-pri 
                    Associated Signaling? y          Max number of NCA TSC: 0 
                       Primary D-Channel: 01B0824     Max number of CA TSC: 0 
                                                   Trunk Group for NCA TSC: 
       Trunk Group for Channel Selection: 62 
          Supplementary Service Protocol: a 
 

 

3.5. Administer ISDN Trunk Group Members 
Use the “change trunk-group n” command, where “n” is the trunk group number added in 
Section 3.3.  Navigate to Page 4 of the TRUNK GROUP screen, and enter an available port of 
the DS1 circuit pack into the Port field, and the corresponding Code and Sfx fields will be 
populated automatically.  Enter the ISDN signaling group number from Section 3.4 into the Sig 
Grp field as shown below.   
 
Repeat this procedure for the desired number of trunk group members, which would be the same 
as the desired number of maximum simultaneous incoming PRI calls.  For the compliance 
testing, five trunk group members are used, and hence five simultaneous incoming PRI calls.  
Submit these changes. 
 
change trunk-group 62                                           Page   4 of  20 
                                 TRUNK GROUP 
                                      Administered Members (min/max):   1/5 
GROUP MEMBER ASSIGNMENTS                  Total Administered Members:   5 
 
       Port    Code Sfx Name        Night           Sig Grp 
  1: 01B0801  TN464  G                                62 
  2: 01B0802  TN464  G                                62 
  3: 01B0803  TN464  G                                62 
  4: 01B0804  TN464  G                                62 
  5: 01B0805  TN464  G                                62 
  6: 
  7: 
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3.6. Administer Analog Stations 
Use the “add station n” command, where “n” is an available extension number.  Enter the 
following values for the specified fields, and retain the default values for the remaining fields.  
Submit these changes.   
 

• Type: “2500” 
• Port:     Enter an available port on the Analog Line circuit pack. 
• Name:     Enter a descriptive name. 

 
add station 29901                                               Page   1 of   3 
                                     STATION 
 
Extension: 29901                           Lock Messages? n          BCC: 0 
     Type: 2500                            Security Code:             TN: 1 
     Port: 01B1301                       Coverage Path 1:            COR: 1 
     Name: Analog Endpoint-1             Coverage Path 2:            COS: 1 
                                         Hunt-to Station:          Tests? y 
 
STATION OPTIONS 
              Loss Group: 1                 Message Waiting Indicator: none 
    Off Premises Station? n 
 
 
 
          Survivable COR: internal 
   Survivable Trunk Dest? y 
 

 
Repeat the “add station n” command to add the desired number of analog stations, which would 
be the same as the desired number of simultaneous calls.  For the compliance testing, five analog 
stations were administered as shown below.  When possible, use consecutive extension numbers 
for the analog stations, for ease of configuring Abacus 5000. 
 
list station 29901 count 5 
 
                                  STATIONS 
 
Ext/     Port/    Name/                       Room/         Cv1/ COR/    Cable/ 
 Type    Hunt-to  Surv GK NN          Move    Data Ext      Cv2  COS     Jack 
 
29901    01B1301  Analog Endpoint-1                              1 
 2500                                 no                         1 
29902    01B1302  Analog Endpoint-2                              1 
 2500                                 no                         1 
29903    01B1303  Analog Endpoint-3                              1 
 2500                                 no                         1 
29904    01B1304  Analog Endpoint-4                              1 
 2500                                 no                         1 
29905    01B1305  Analog Endpoint-5                              1 
 2500                                 no                         1 
 



4.  Configure Abacus 5000 
The procedures for configuring the originating ISDN and terminating analog interfaces on 
Abacus 5000 to interoperate with Avaya Communication Manager include the following areas: 
 

• Verify system information 
• Administer protocol selection 
• Administer phones 
• Administer channels 
• Administer partitioning and timing 
• Increase script holdoff threshold 

 
As part of the installation, the Abacus 5000 user interface software is installed on a standalone 
PC, and used to configure the IP address for the system and to connect to the system. 
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4.1. Verify System Information 
From the PC running the Abacus 5000 user interface, navigate to Start > Programs > Abacus 
5000 > 3.2 > Abacus to open the Abacus 5000 window.  Select View > System Information 
from the main menu bar as shown below. 
 

 
 



The System Information screen is displayed, and shows the cards that are available in the 
system.  For the compliance testing, a PCG3B card is used to originate ISDN PRI calls over the 
ISDN trunks to Avaya Communication Manager, and an ECG3 card to terminate the calls to the 
analog stations from Avaya Communication Manager.  Release any extra card by selecting the 
green grid that corresponds to the card in the right pane, in this case “ICG3”, and click on the 
Release button in the bottom of the pane to release the card.  Repeat this procedure to release all 
extra cards.   
 

 

 
TLT; Reviewed: 
SPOC 5/26/2006 

Solution & Interoperability Test Lab Application Notes 
©2006 Avaya Inc. All Rights Reserved. 

10 of 33 
Abacus-TDM.doc 

 



Next, verify the license on each of the cards.  Select the ECG3 card in the directory pane in the 
upper left section of the window, and click on the Options tab in the lower left pane to view the 
available options the card supports.  Verify that the Call generation, PSQM\PSQM+ or PESQ 
options are enabled with a corresponding check mark in the available column. 
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Select the PCG3B card in the directory pane in the upper left section of the window, and click 
on the Options tab in the lower left pane to view the available options the card supports.  Verify 
that the Call generation, T1 or E1, PRI – NA, ETSI, ITU options are enabled with a 
corresponding check mark in the available column.  Scroll down the lower left pane to also 
verify that the PSQM/PSQM+ or PESQ Analysis option is enabled (not shown below).  After 
verifying the options on both of the cards, click on Close. 
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4.2. Administer Protocol Selection 
Click on the Ptl Selection icon from the main menu bar shown below.   
 

 
 

4.2.1. Administer Protocol Selection Card 
In the Card tab, right click in the Signalling field for the PCG3B card, and select the option 
Select From List from the drop down (not shown below).  This sets the clicking option for all 
fields on this screen. 
 
Left click on the same Signalling field. Select “ISDN” from the list, as shown below.   
 

 
 
After the selection, the default value for the Circuit field will automatically be changed to  
“Pt Sub”.   In addition, a new ISDN tab will be created automatically by Abacus 5000 and 
appears between the Channels and Analog tabs, as shown below. 
 
Maintain the default values in the SUT, Channels, ISDN, and Analog tabs.  Proceed to 
administer the Circuits tab. 
 

 



4.2.2. Administer Protocol Selection Circuits 
Select the Circuits tab.  For the ECG3 card, disable any unused circuits by selecting the 
corresponding grids and clicking on the Disable Selected button in the bottom of the screen.  For 
the compliance testing, five circuits were used from the ECG3 card, each with a physical 
connection to a port on the Analog Line circuit pack on Avaya Communication Manager. 
 
For the PCG3B card, also disable any unused circuits by selecting the corresponding grids and 
clicking on the Disable Selected button in the bottom of the screen.  Each circuit on the PCG3B 
card has a capacity of 23 B-channels.  For the compliance testing, one circuit was used from the 
PCG3 card, as only 5 B-channels were needed.  The PCG3B card has a physical connection to 
the DS1 Interface circuit pack on Avaya Communication Manager. 
 
Maintain the default values in the DS1 tab.  Click on OK at the bottom of the screen to submit 
these changes. 
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4.3. Administer Phones 
Click on the Phones icon from the main menu bar.   
 

 

4.3.1. Administer Phones PRI 
The Phone numbers screen is displayed.  Select the PRI T1 Sub tab from the bottom of the 
screen, and administer telephone numbers for the originating PCG3B card.  The Own row is 
used to administer the internal telephone numbers, and the External row is used to administer 
the external telephone numbers for the card to dial. 
 
For the Own row, maintain the default value for the Source field.  In the File name or starting 
number field, enter the desired starting digits to be passed to Avaya Communication Manager as 
calling party numbers.   
 
For the External row, maintain the default value for the Source field.  In the File name or 
starting number field, enter the starting analog station number from Section 3.6.  Note that in 
the case that the analog station numbers are not sequential, the user needs to click on the 
corresponding Source field to select the option “File” to create a file for the external telephone 
numbers, and manually enter each analog station number into the file.   
 
Maintain the default selection for the Numbers apply section, and click on the Analog Sub at 
the bottom of the screen. 
 

 



4.3.2. Administer Phones Analog 
The associated Phone numbers screen is displayed for the Analog Sub tab.  The Own row is 
used to administer the internal telephone numbers, and the External row is used to administer 
the external telephone numbers for the card to dial out to. 
 
For the Own row, maintain the default value for the Source field.  In the File name or starting 
number field, enter the starting analog station number from Section 3.6.  Note that in the case 
that the analog station numbers are not sequential, the user needs to click on the corresponding 
Source field to select the option “File” to create a file for the internal telephone numbers, and 
manually enter each analog station number into the file.   
 
For the External row, maintain the default values, as the ECG3 card will not be dialing out to 
any numbers. 
 
Click on OK at the bottom of the screen to submit these changes. 
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4.4. Administer Channels 
Click on the Channels icon from the main menu bar.   
 

 

4.4.1. Administer Channels Path Confirm PRI 
The Channels screen is displayed next.  The Path Confirm tab is used to select the two-way 
speech verification mechanism for the originating and terminating channels for each call.  The 
remaining tabs are not used and can retain the default values.  Select the Path Confirm tab. 
 
Select the PRI T1 tab located at the bottom of the screen, followed by the Advanced sub tab.  
Select QoM, and PESQ in the Voice section of the screen.  Retain the default values for all 
remaining fields.   
 
Note that PSQM and PESQ are ITU standards P.861 and P.862 respectively for assessment of 
speech quality.  PESQ is the more recent standard with a higher accuracy than PSQM, based on 
the comparison results published by the Audio Engineer Society Convention.  If PSQM is 
optioned on the PCG3B and ECG3 cards instead of PESQ, then select PSQM and enable the 
Plus field. The “Longs-mu” file is a relatively longer WAV file to use for voice path 
confirmation, and other WAV files may be used.   
 

 



4.4.2. Administer Channels Path Confirm Analog 
Select the Analog tab located at the bottom of the screen, followed by the Advanced sub tab.  
Select QoM, and PESQ in the Voice section of the screen.  Retain the default values for all 
remaining fields.  Click on OK to submit these changes. 
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4.5. Administer Partitioning and Timing 
Click on the Partition icon from the main menu bar.   
 

 

4.5.1. Administer Association PRI 
The Partition and Timing screen is displayed.  Select the Association tab.  Click on the PRI T1 
Subscriber: 23B + 1D sub tab on the bottom left of the screen, and update the following fields: 
 

• From and To:      Update to reflect the range of B-channels used on the PCG3B card. 
• Total:                   Field automatically updated by Abacus 5000. 
• Configuration: “all originate” 
• Links: “External” 

 
In this case, five channels on the PCG3B card will be used to originate the ISDN PRI calls.   
 
The “Default” value can be retained for the Path Confirmation field, as the path confirmation 
method has already been administered in Section 4.4.1. 
 

 



4.5.2. Administer Association Analog 
Click on the Analog Subscriber: 5 tab located on the bottom left of the screen.  Enter the 
following values into the specified fields: 
 

• From and To:      Update to reflect the range of channels used on the ECG3 card. 
• Total:                   Field automatically updated by Abacus 5000. 
• Configuration: “all terminate” 
• Links: “External” 

 
In this case, five channels on the ECG3 card will be used to terminate the calls.   
 
The “Default” value can be retained for the Path Confirmation field, as the path confirmation 
method has already been administered in Section 4.4.2. 
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4.5.3. Administer Timing and Scripts PRI 
Select the Timing and Scripts tab.  Click on the PRI T1 Subscriber: 23B + 1D sub tab on the 
bottom left of the screen, and update the ST, SS, CL, IC, and CC fields to the desired values.  
Below is a brief description of what each abbreviated field stands for from the Abacus 5000 
documentation: 
 

 
 
Note that the value for the IC (Inter-Call) field needs to be a minimum of “20” seconds, as this is 
the amount of time necessary to allow for proper tear down of calls to analog stations.   
 
Select the script “A calls B (ISDN) and confirms for Call Length” for the Script originate field. 
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4.5.4. Administer Timing and Scripts Analog 
Click on the Analog Subscriber: 5 sub tab located on the bottom left of the screen, and update 
the CL field to the desired value.   
 
Maintain the default values in the Protocols and Phones tabs.  Click on OK at the bottom of the 
screen to submit these changes. 
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4.6. Increase Script Holdoff Threshold 
A script holdoff error can occur when the protocol has not reached the answer state within the 
threshold value, and occasionally an analog channel may take longer than 10 seconds to reach 
the answer state.  For the compliance testing, the script holdoff threshold was increased to 20 
seconds to minimize this random error.  Select Configure > Threshholds and Errors from the 
main menu bar, to increase the threshold value for the script holdoff parameter. 
 

 
 

The Thresholds and Errors screen is displayed.  Click on the PRI T1 tab at the bottom left of 
the screen, followed by the Regular sub tab.  In the Error Condition column, locate the Script 
holdoff parameter and change the corresponding value in the Thrsh column from “10.0” to 
“20.0”, as shown below.  Repeat this procedure for the Analog tab, and click OK at the end to 
submit the changes. 
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5.1. 

5.2. 

5. Interoperability Compliance Testing 
The interoperability compliance testing focused on the following areas: 
 

• Generation of moderate ISDN PRI telephony load to Avaya Communication Manager via 
the ISDN trunk interface, and back out to Abacus 5000 via the analog station interface. 

• Voice quality as measured by PESQ scores with path confirmation. 
• Recovery from adverse conditions during the load test. 

General Test Approach 
The feature test cases were conducted by using Abacus 5000 to originate ISDN PRI calls to 
Avaya Communication Manager, and to terminate the calls to analog stations on Abacus 5000.  
The serviceability test cases were performed by disconnecting and reconnecting the physical 
cables to the Abacus 5000 originating PCG3B and terminating ECG3 cards. 
 
The verification included monitoring the various reports from Abacus 5000 during and after the 
test runs, and checking the status of various ISDN and analog resources on Avaya 
Communication Manager. 

Test Results 
All test cases that were executed were passed. 
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6.1. 

6. Verification Steps 
This section provides the tests that can be performed to verify proper configuration of ISDN and 
analog interfaces between Avaya Communication Manager and Abacus 5000. 

Verify Avaya Communication Manager 
Verify the status of the ISDN trunk group by using the “status trunk n” command, where “n” is 
the trunk group number administered in Section 3.3.  While the trunks are connected with active 
calls, verify the Service State for each connected trunk is “in-service/active” as shown below. 
 
status trunk 62 
 
                             TRUNK GROUP STATUS 
 
Member   Port     Service State      Mtce Connected Ports 
                                     Busy 
 
0062/001 01B0801  in-service/active  no   01B1301 
0062/002 01B0802  in-service/active  no   01B1302 
0062/003 01B0803  in-service/active  no   01B1303 
0062/004 01B0804  in-service/active  no   01B1304 
0062/005 01B0805  in-service/active  no   01B1305 
 

 
Verify the status of the ISDN signaling group by using the “status signaling-group n” command, 
where “n” is the signaling group number administered in Section 3.4.  Verify that the signaling 
group is “in-service” as indicated in the Group State field shown below. 
 
status signaling-group 62 
                         STATUS SIGNALING GROUP 
 
        Group ID: 62                              Active NCA-TSC Count: 0 
      Group Type: isdn-pri                         Active CA-TSC Count: 0 
  Signaling Type: facility associated signaling 
     Group State: in-service 
 
 
                           Primary D-Channel 
 
 
            Port: 01B0824        Level 3 State: in-service 
 
 
                          Secondary D-Channel 
 
 
            Port:                Level 3 State: no-link 
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Verify the status of a connected analog station during an active call using the “status station n” 
command, where “n” is the extension of the connected station.  On Page 1, verify the Service 
State is “in-service/off-hook”.  Also verify the analog station is connected to an ISDN trunk, as 
shown below in the Connected Ports field. 
 
status station 29901                                            Page   1 of   4 
                              GENERAL STATUS 
     Administered Type: 2500               Service State: in-service/off-hook 
        Connected Type: N/A           Parameter Download: not-applicable 
             Extension: 29901              SAC Activated? no 
                  Port: 01B1301         User Cntrl Restr: none 
           Call Parked? no             Group Cntrl Restr: none 
      Ring Cut Off Act? no            CF Destination Ext: 
Active Coverage Option: 1 
 
          EC500 Status: N/A        Off-PBX Service State: N/A 
       Message Waiting: 
   Connected Ports: 01B0801 
 
 
 
 
                                               HOSPITALITY STATUS 
                                            Awaken at: 
                                             User DND: not activated 
                                            Group DND: not activated 
                                          Room Status: non-guest room 

 
On Page 3, verify the analog station and the connected ISDN trunk have a talk path.  
 
status station 29901                                            Page   3 of   4 
                      SRC PORT TO DEST PORT TALKPATH 
src port: 01B1301 
01B1301:TX:tdm:a198 
01B0801:RX:tdm:a198 
 
 
dst port: 01B0801 
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Verify the status of a connected ISDN trunk by using the “status trunk x/y”, where “x” is the 
number of the ISDN trunk group from Section 3.3 and “y” is the member number of a connected 
trunk.  On Page 1, verify the Service State is “in-service/active.  Also verify the ISDN trunk is 
connected to an analog station, as shown below in the Connected Ports field. 
 
status trunk 62/1                                               Page   1 of   2 
                              TRUNK STATUS 
 
 Trunk Group/Member: 0062/001              Service State: in-service/active 
               Port: 01B0801            Maintenance Busy? no 
 Signaling Group ID: 62                     CA-TSC state: none 
 
 
 
    Connected Ports: 01B1301 
 
            Video: 
      Video Codec: 
                                            Authentication Type: None 
 

 
On Page 2, verify the ISDN trunk and the connected analog station have a talk path.  
 
status trunk 62/1                                               Page   2 of   2 
                      SRC PORT TO DEST PORT TALKPATH 
src port: 01B0801 
01B0801:TX:tdm:a233 
01B1301:RX:tdm:a233 
 
 
dst port: 01B1301 
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6.2. Verify Abacus 5000 
Click on the Start icon from the main menu bar.  
 

 
 
Verify that the scripts can be compiled successfully without any errors, as shown in the screens 
below. 
 

 
 

 



Verify the channel status by clicking on the Channel Status icon from the main menu bar. 
 
Click on the PRI T1 Subscriber: 5B+1D tab.  When the calls have been established, then the 
color code for the originating channels 1-5 will turn green, as shown below. 
 

 
 
Click on the Analog Subscriber: 5 tab.  When the calls have been established, then the color 
code for the terminating channels 1-5 will turn yellow, as shown below. 
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Verify the statistics by clicking on the Statistics icon from the main menu bar.  In the Statistics 
screen displayed below for the PRI T1 Subscriber: 5B + 1D tab, look for Script attempts, 
Script completions, and the absence of any Errors.  The Statistics screen below was captured 
during a test run, therefore the number in the Script completions fields shown are one behind 
the number in the Script attempts fields. 
 

 
 
Click on the Analog Subscriber: 5 tab on the bottom of the screen to view the statistics 
associated with the analog subscribers.  Look for Call attempts, Call completions, and the 
absence of any Errors.   
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Verify the variances by clicking on the Variances icon from the main menu bar.  In the 
Variances screen displayed below, look for PESQ scores.  PESQ scores range from -0.5 to 4.5, 
where 4.5 indicates there is no perceptible difference between the original speech sample and the 
degraded signal.  
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7. Support 
Technical support on Spirent Abacus 5000 can be obtained through the following: 
 

• Email the Spirent support center via support@spirentcom.com.  
• Call the Spirent support center at 1-800-SPIRENT. 

8. Conclusion 
These Application Notes describe the configuration steps required for Spirent Abacus 5000 
Release 3.2 to successfully interoperate with Avaya Communication Manager 3.0.1 using the 
ISDN PRI and analog interfaces.   All feature and serviceability test cases that were executed 
completed successfully. 

9. Additional References  
This section references the product documentation relevant to these Application Notes.   
 

• Administrator Guide for Avaya Communication Manager, Document 03-300509, Issue 1, 
June 2005, available at http://support.avaya.com 

 
• Abacus 5000 IP Telephony Migration Test System, available from the Spirent Abacus 5000 

Version 3.2 Installation CD. 

mailto:support@spirentcom.com
http://support.avaya.com/
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